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Shareware Registration

You may use this program for evaluating the software to see if it will fit your needs.    If you continue to use
it after a reasonable trial period, you must pay the $37.00 registration fee to Sapphire Software Inc.    
When you register, you will receive the following:

1. The currently available regular version of the program (without the registration reminder screens).

2. A single-user license to run the regular version on one computer for one user.

3. A User Manual.

4. Discounts on new versions of the program as they become available.

5. One year of free telephone/electronic mail support.

6. A copy of the current regular version of Clickometer™ (a $15 value).    Knowing when to take a 
break may help to reduce repetitive-strain injuries (RSI).    This Windows utility counts keystrokes, 
mouse clicks, and tracks mouse movement.    It issues warning notices when activity thresholds 
are exceeded.    Real-time counters are displayed like odometers.    Reports show profiles of user 
input activity. On-line help is provided.    The Dynamic Link Library can be used by your own 
programs.

How to Register using the Program 
1. Select the "Registration" option from the "Help" menu and fill in the form that appears.

2. Use the "Print" button to print the registration form.

3. Verify the printed information and manually complete the registration form.    Please add any 
comments or suggestions that you may have.

4. Mail the registration form and your check (made payable to Sapphire Software Inc. in USA funds) to 
the address shown on the registration form.

How to Register with CompuServe
CompuServe offers a shareware registration service that will bill the registration fee to your CompuServe 
account.    If you use this service (GO SWREG), the registered version of the product is usually shipped 
on the next working day.

How to Register with Credit Cards
You can order with MC, Visa, Amex, or Discover from Public (software) Library by calling 800-2424-PsL or
713-524-6394 or by FAX to 713-524-6398 or by CIS Email to 71355,470. You can also mail credit card 
orders to PsL at P.O.Box 35705, Houston, TX 77235-5705.

THE ABOVE NUMBERS ARE FOR ORDERS ONLY.

Any questions about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, etc, must be directed to Sapphire 
Software Inc.

To insure that you get the latest version, PsL will notify us the day of your order and we will ship the 
product    directly to you.

PsL has assigned product #11168 to A Project/Event Planner.





Letter to User

Dear User:

Thank you for considering this program for your use.    Before you use this software, you must accept the 
following Disclaimer of Warranty:

THIS SOFTWARE IS SUPPLIED AS IS.    SAPPHIRE SOFTWARE INC. 
DISCLAIMS ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, 
WITHOUT LIMITATION, THE WARRANTIES OF MERCHANTABILITY AND OF 
FITNESS FOR ANY PURPOSE.    SAPPHIRE SOFTWARE INC. ASSUMES NO 
LIABILITY FOR DAMAGES, DIRECT OR CONSEQUENTIAL, WHICH MAY 
RESULT FROM THE USE OF THIS SOFTWARE.

This agreement shall be governed by the laws of the State of Hawaii.

You may use this program for a reasonable time period to see if it fits your needs.    If you continue to use 
this program after the trial period, payment of a registration fee is required.    Refer to the Shareware 
Registration for additional information.

Please contact me if you have any questions, problems, or suggestions regarding the program.    See the 
Support topic for additional information.

Sincerely,

Layton S. Fujii
Sapphire Software Inc.



General Overview

This program is designed to give you the flexibility of managing projects or other activities in a dynamic 
environment where you may need to adjust your plans frequently.    You can quickly create any plan to get
ballpark schedule, cost, and income estimates.    For example, you may use it to:

1. Schedule and estimate a construction project.

2. Schedule and estimate a landscape project.

3. Schedule and estimate a software development project.

4. Track the overall schedule and costs of jobs.

5. Use it as a planning "white-board" where you just draw out your tasks over a specific time period.

6. Schedule resource usage (such as conference rooms, vehicles, etc.).

To create any plan, a planning grid is presented that looks like a spreadsheet.    The columns of the 
planning grid represent time with time increasing as you move to the right.    Each row in the planning grid 
is used to determine the vertical placement of an event.

To create an event on the planning grid, you simply draw it:

1. Position the mouse cursor at the desired location and start time on the planning grid.

2. Press the mouse button, drag the mouse cursor (to the right) for the desired time period for the 
event, and release the mouse button.    A rectangle (event bar) representing the event will be 
drawn.

To move the event bar, position the mouse cursor over the event, press the mouse button, drag the event 
to the desired position, and release the mouse button.

To change the duration of an event, position the mouse cursor over the right or left edge of an event, 
press the mouse button, drag the edge of the event bar to the desired position, and release the mouse 
button.

Each event may be assigned several resources.    The time availability of each resource is determined by
a calendar.    All resources may use the same calendar or each resource may use its own unique 
calendar.

For each event you may define a fixed start time or you may specify predecessors to an event that must 
complete before the event starts.

For each event you may specify a duration and have the program automatically calculate how many 
hours will be needed by each resource assigned to the event.    Or you may specify how many resource 
hours are needed for an event and the program will automatically calculate the duration of an event.



Calendar Overview

A calendar defines the available time for a resource.    Many resources may use the same calendar or 
each resource may use a unique calendar.

The calendar document window is divided into two areas.    On the left is the layout of the currently 
selected month.    On the right side is the schedule for the currently selected day or days of the month.    
Days to be assigned a schedule are selected by clicking directly on the desired day in the monthly 
display.    Whenever a new day is selected, the associated schedule for the day is automatically displayed 
in the schedule display area on the right.

Monthly Display Area (left side)
To change the monthly display to a different month, use the horizontal scroll control that is located to the 
left of the month display title.

To change the year of the month display, use the horizontal scroll control that is located to the right of the 
month display title.

Days that are assigned schedules (other than the default condition) are shaded.

Schedule Display Area (right side)
A schedule defines the available hours for the selected days.    Many schedules may be defined for a 
given calendar.

The available time is represented in the vertical box labeled "Time".    The color next to the time indicates 
the availability of the time slot (usually green means available and red means not available).

To change the time schedule, click on the time and the associated color status area will change to the 
opposite state.    To change the state of a continuous time period, press the mouse button over the 
beginning time, drag the mouse cursor to the end time, and release the mouse button.

Schedules may be of the following types:

Default - The default schedule defines the daily schedule for all days that have no other schedule 
assigned.

Pattern - The pattern schedule defines the same schedule for the specified days of the week.    For 
example, all Saturdays may be defined to have the same schedule.

Every Month - This type of schedule defines the schedule for days of a month.    For example, the 
15th day of every month could be defined to have a certain schedule.

Every Year - This type defines the schedule for a month and day of each year.    For example, this 
can be used to define a schedule for a holiday such as January 1st for New Year's Day.

Do Not Repeat - This type defines a schedule for a specific date that occurs once and will not be 
repeated.    For example it can be used to specify the vacation dates for an employee.

Selecting Days for a Schedule
First adjust the monthly display so the proper month is shown.

To select a single day, click on the desired day of the month.

To select a period of contiguous days, position the mouse cursor on the first day of the period, press 
the mouse button, drag the mouse cursor to the last day of the period, and release the mouse button.



To select a day of the week, click on the name of the day at the top of each column of days.

Refer to How to Work with Calendar Schedules for additional information.



Plan Overview

A plan consists of a group of events.    For each event, information such as its start time, end time, 
resources required, cost, and income amounts are stored.

The visual layout of a plan is similar to the rows and columns of a spreadsheet.    For the planning grid 
however, time is always on the horizontal axis and a line number is on the vertical axis.    Horizontal and 
vertical scroll bars are provided to move in time or rows respectively.

Each event appears as a rectangle that is positioned on the planning grid at the proper time slot.    Events 
in a plan are created by using the mouse or the Edit - New menu option.

To create an event on the planning grid with the mouse:

1. Position the mouse cursor at the desired location and start time on the planning grid.

2. Press the mouse button, drag the mouse cursor (to the right) for the desired time period for the 
event, and release the mouse button.    A rectangle (event bar) representing the event will be 
drawn.

To move the event bar, position the mouse cursor over the event, press the mouse button, drag the 
event to the desired position, and release the mouse button.

To change the duration of an event, position the mouse cursor over the right or left edge of an event, 
press the mouse button, drag the edge of the event bar to the desired position, and release the mouse 
button.

To view the details of an event, double-click on the desired event or use the Edit - Modify menu option.

Events can be created in a "free-form" manner so they may be defined anywhere on the surface of the 
planning grid.    As an event is created, the start and end times are automatically assigned based on the 
position it is drawn on the grid.

An event can be related to another by specifying one or more predecessor events.    In this case the event
cannot start until the latest completion of all the defined predecessor events.    When the completion time 
of a predecessor event is changed, the start time of the subsequent event is automatically calculated.

Refer to How to Create a Plan and How to Modify an Event for more detailed information.



Resource Overview

Each event in a plan requires that at least one resource be assigned to it.    Typically, a resource is a 
person.    But you may define a resource to be any entity that can be associated with a calendar time 
frame.    For example a resource could be a vehicle that you charge out at an hourly rate.    If you assign 
tasks to groups or crews of workers, you could define a resource for each group or crew.

Refer to How to Create a Resource for more information.



Multiple Document Interface

This application uses the Window's Multiple Document Interface capabilities to manage the display.    
Each plan, resource, or calendar is displayed in a separate document window so it is possible to view 
several plans, resources, and calendars at the same time.

The "Window" menu can be used to arrange the opened documents.



Limitations

1. This program is not intended for use when you have to define thousands of events for a plan.    It is 
recommended that no more than a few hundred events be created for any plan.

2. You may access plan data created by earlier versions of this program.    But once you modify or create
plan data with this version, the plan data will not be compatible with earlier versions of this program.

3. The resource and calendar information are referenced when a plan is loaded.    If you change a 
calendar after a plan is loaded (i.e. visible in a plan document window) the plan information will not be
automatically changed to reflect the new calendar.    To see the effect of the new calendar definition, 
close the changed calendar and the opened plan, then re-open the plan.



Installation

As a precautionary measure, make a backup of any previously installed versions and associated data 
files before proceeding with the installation.    The following installation instructions assume that all of the 
files are on a diskette or are located in a single directory on a hard disk.

Standard Installation using INSTALL Utility
1. From the Windows Program Manager or File Manager, select the Run option in the File menu.    In 

response to the "Command Line:" prompt, enter the location of the INSTALL utility.    For example if 
the distribution is located in drive A:, enter the following:

                                        A:\APLANR\INSTALL

2. If all the required files are located, the installation dialog box appears with the options described 
below.    By default all options are selected.

 Install Program into directory: - Click on the check box to select or not select this option.    An X 
appears in the box when the option is selected.    In the edit box at the right, enter the drive and 
directory to place the program.

 Install Samples into directory: - Click on the check box to select or not select this option.    An X 
appears in the box when the option is selected.    In the edit box at the right, enter the drive and 
directory to place the files for the sample plans.

 Create Program Group. - Click on the check box to select or not select this option.    An X appears
in the box when the option is selected.    When this option is selected, a program group named 
"APLANR" with a single program item will be created.    The "Program Item Properties" dialog box for 
this program item will contain the following values:

Description: APLANR x.y (x.y represents the program version)
Command Line: <path as specified in program directory>\APLANR.EXE
Working Directory: <path as specified in samples directory>

3. Click on OK to complete the installation.    It should complete in less than a minute.

4. Re-arrange your desktop as necessary to place the new program group at the desired location and 
save the new arrangement so the next time Windows start, your desktop will be arranged as you like 
it.

Manual Installation - Full Install
1. Create a directory where you want APLANR to reside in.    You may use the Windows File Manager or

DOS.

2. Copy all the program files from the diskette to the new directory.    You may use the Windows File 
Manager or DOS.

3. For example if your files reside in A: and you want to install them into C:\APLANR, in DOS type:

MD  C:\APLANR
COPY  A:\APLANR\*.*  C:\APLANR

4. You may now execute the program named "APLANR.EXE" directly with the Windows File Manager.

5. If you want to set up an icon in a program group to execute APLANR.EXE, refer to the "Working with 
Program Items" section in the Program Manager chapter of the Windows User's Guide.    Using the 



same example as above, you enter the following in the "Program Item Properties" dialog box:
Description: APLANR
Command Line: C:\APLANR\APLANR.EXE
Working Directory: C:\APLANR

Manual Installation - Program Only
You do not have to copy all of the files to your disk, but the required files are "APLANR.EXE" and 
"APLANR.HLP".    These are the program executable and help files respectively.

Use the DOS copy command or the Windows File Manager to replace the old APLANR.EXE (program 
executable) and APLANR.HLP (program help file) with the new versions from the distribution diskette.    
The new versions use the same filenames.    For example if your old files reside in "C:\APLANR", sample 
commands to copy the files are:

COPY  A:\APLANR\APLANR.EXE  C:\APLANR
COPY  A:\APLANR\APLANR.HLP  C:\APLANR

Manual Installation - Samples Only
To install the sample data, you just need to copy the sample files.    The sample files all start with the 
letters "PV".    For example if "C:\APLANR" holds the executable programs, you could create a directory 
"C:\APLANR\SAMPLES".    A sample command to copy all the sample data from a diskette in drive A is 
given below:

COPY  A:\APLANR\PV*.*  C:\APLANR\SAMPLES
                        
You can then use the "Directories" option of the "Options"    menu to tell the program to use this directory 
to access the sample data.

***DO NOT*** copy the sample plans of the new version into the same directory as your current plan files,
because the sample plan files will over-write yours.



Distributed Files

Required to Run the Application
aplanr.exe "A Project/Event Planner" program executable.

aplanr.hlp On-line help file.    You may also view this file directly with the Windows Help utility 
(winhelp.exe).    On most systems you can double-click on this file from the Windows File 
Manager and help will be automatically executed to show you the contents of this file.

Informational Files (may be viewed by any text editor)
features.txt This provides a summary description of the software.

file_id.diz This is a short description of the program, primarily for BBS use.

install.txt Provides information about how to install this program.

letter.txt A letter from the author to the user, including the user agreement information.

readme.txt Read this first.    It tells you where to get information in the various files.

register.txt If you do not use the program's "Registration" option in the "Help" menu, this provides 
information on how to register this program.

release.txt This summarizes the changes between this version and the previous version.    It may also 
contain new information that could not be included elsewhere.

vendor.txt This information is for shareware vendors and bulletin board system operators.

Sample Data Files
pvcal.dat Calendar definitions file.

pvidx.dat Plan index file which keeps track of the various plan names.

pvrsc.dat Resource definitions file.

pvyymmdd.sss Each plan is stored in a file with a name in this format.    Several sample plans are 
distributed.    Each plan file always starts with "pv".    "yy" is the last two digits of the year 
when the plan file was originally created.    "mm" is the two digit equivalent of the month of 
the year.    "dd" is the day of the month.    "sss" is an assigned sequence number if more 
than one plan was created on the same day.

Other Files
install.exe Installation utility.
\zip\aplanrxy.zip - (Only on disks from Sapphire Software Inc.)    This file contains the above files in PKZIP

2 compressed format.    The "xy" in the filename represents the program version. For 
example "30" refers to version 3.0.



Windows Initialization File

The Windows initialization file for this program is named "aplanr.ini" and is located where Windows keeps 
its other ".ini" type files.    It is automatically created and maintained by the program.

In general, since most of the settings in this file can be changed by selecting the appropriate program 
options, you should not have to modify the initialization file.    However, some options can only be changed
by manually editing this file.    Some of these options are described below.

NOTE:    If you decide to modify the file, please be sure to make a backup 
copy first and be sure that the modifications are made in the proper format. 
If the program does not work properly after your modifications, revert back 
to your previous copy.    Or delete the initialization file, and the program will 
create a new one automatically.

DefaultEventBkgd - This defines the default background color (in red, green, blue values) for event bars.

DefaultEventBorder - This defines the default color (in red, green, blue values) for event bar borders.

DefaultEventText - This defines the default color (in red, green, blue values) for the event name in event 
bars.

DefaultGridBkgd - This defines the default background color ( in red, green, and blue values) for a plan.

DefaultGridLabels - This defines the default color ( in red, green, and blue values) for the labels in a 
plan.

DefaultGridLines - This defines the default color ( in red, green, and blue values) for the lines that make 
up the planning grid.



Support

Telephone Support
(808) 395-5587 (Hawaii time).    Voice messages taken during off-hour periods.

CompuServe
Send messages to 71223,3653.

Send Correspondence to:
Sapphire Software Inc.
6650 Hawaii Kai Drive
Suite 219
Honolulu, Hawaii    96825-1140
USA

ASP
This program is produced by a member of the Association of Shareware Professionals (ASP).    ASP 
wants to make sure that the shareware principle works for you. If you are unable to resolve a shareware-
related problem with an ASP member by contacting the member directly, ASP may be able to help. The 
ASP Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products.    Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442 or send a CompuServe message via CompuServe Mail to ASP Ombudsman 
70007,3536.



How to Create a Calendar

Select the "New" option from the "File" menu and a dialog box will appear.    Select the "Calendar" 
document type and select "OK" to create a new calendar.    After defining the schedules for the calendar, 
select the "Close" option from the "File" menu.    A dialog box will prompt for the name of the new 
calendar.    Enter the name of the calendar and select "OK" to create the new calendar.

To create a new calendar that is similar to an existing one, open the calendar to be used as a template 
and use the "Save As" option of the "File" menu.

Creating a New Schedule
1. Select the day or days of interest from the monthly display (left side).    To select a single day, click on 

the desired day.    To select a group of days, position the mouse cursor on the first day, press the 
mouse button, drag the cursor to the last day in the group, and release the mouse button.    To select 
the days of a week, click on the name of the day at the top of each column of days.

2. Click on the "New" button and a dialog box will appear.

3. Select a type of schedule (refer to Calendar Overview for a description of the schedule types.) and 
enter a unique name for the new schedule.    Select "OK" to accept the input and close the dialog box. 
The new name will appear in the schedule area display.

4. In the vertical box labeled "Time", define the schedule.    Click on a time to change availability (i.e. the 
resource that uses this calendar is available).    Green indicates available time, red indicates not-
available.    Remember that changing the available time schedule only affects the schedule that is 
currently shown in the "Assigned Schedules" box.

Deleting a Schedule
1. Select a day.    The "Assigned Schedules" list will contain all the schedules that may be applied to the 

selected day.

2. Select the schedule to delete from the "Assigned Schedules" list.

3. Click on the "Delete" button to delete the schedule.

Refer to How to Work with Calendar Schedules for more information.



How to Create a Plan

First define all the calendars needed by the resources.    Next define all the resources needed by the 
plan.    Then create the events for the plan.

Select the "New" option from the "File" menu and select the "Plan" document type to create a new plan.    
Enter the desired events into the document then select the "Close" option from the "File" menu.    A dialog 
box will prompt for the name of the new plan.    Enter the name of the plan and select "OK" to create the 
new plan.

Creating Plan Events - Method 1: 
1. Position the mouse cursor to the desired location on the planning grid.

2. Press the mouse button, drag the mouse cursor for the desired event duration, and release the 
mouse button.

3. The new event will be automatically assigned a temporary name.

4. Double-click on the newly create event to enter detailed event information.    At this time you can give 
the event a name and adjust the time information as needed.    For additional information refer to the 
"How to Modify an Event" topic.

Creating Plan Events - Method 2: 
1. Select the "New" option from the "Edit" Menu.

2. A dialog box will appear.    This dialog box is the same as the one that appears as in step 4 in the first 
method described above.    However, information such as the event name, duration, and line number 
location are not automatically provided.    These will have to be entered.

To create a new plan that is similar to an existing one, open the plan to be used as a template and use the
"Save As" option of the "File" menu.



How to Create a Resource

Select the "New" option from the "File" menu and select the "Resource" document type to create a new 
resource.    Enter the desired data into the document then select the "Close" option from the "File" menu.   
A dialog box will prompt for the name of the new resource.    Enter the name of the resource and select 
"OK" to create the new resource.

The following resource information fields are available for input:

Description - Enter a description for this resource.

Calendar - Select a calendar to be used by this resource.    This will be the default calendar selection 
whenever this resource is chosen for an event.

Usage % - Enter a percent utilization of available calendar time by this resource.    If you want the 
resource to be used fully, enter 100.    If you want the resource to be used only half of the available 
calendar time, enter 50.

Class - This is just used to classify the resource so that you may identify similar resources.

Income - Enter an amount in dollars that is used to calculate the amount of income generated by this 
resource per specified minutes of time.    This value may be entered with a decimal point for fractions 
of a dollar.

Cost - Enter an amount in dollars that is used to calculate the amount of cost generated by this 
resource per specified minutes of time.    This value may be entered with a decimal point for fractions 
of a dollar.

per - The number of minutes per income or cost amounts.

Notes - Additional notes about the resource.

To create a new resource that is similar to an existing one, open the resource to be used as a template 
and use the "Save As" option of the "File" menu.



How to Modify an Event

To move an event, position the mouse cursor over the event, press the mouse button, drag the event to 
the desired position, and release the mouse button.

To change the start or end time of an event, position the cursor near the left or right edge of the event 
bar until a horizontal arrow cursor appears.    Press the mouse button, drag the edge to the desired 
position, and release the mouse button.

To modify event information, double-click on the event or select the "Modify" option from the "Edit" 
Menu.    A dialog box will appear with the following information.

Name - Each event must have a unique (case-sensitive) name.    This name appears in the event bar if an
X is placed in the check box located just to the left of the "Name" label.    Click in the check box to place 
an X in it.    Click again to remove the X.

Description - Additional information to describe the event.    The description appears in the event bar if an
X is placed in the check box located just to the left of the "Description" label.    Click in the check box to 
place an X in it.    Click again to remove the X.

Start Time - The start time for the event.    If this event has predecessors defined, the start time will be 
automatically calculated.    If no predecessors are defined enter this information in "MM/DD/YY HH:II" 
format where:
 MM = month (1-12)

DD = day of month (1-31)
YY = last two digits of year (92 = 1992, 01 = 2001)
HH = hour of day
II = minutes of hour

End Time - The end time is automatically calculated and displayed.

Duration - This is the elapsed time from the start time to the end time.

Resource Usage - The information in this box refers to resource utilization.

Total Time - This is the total amount of resource time that is allocated from all the resources for this 
event.    Below the total time is a list box which shows how much time is allocated to each resource.

Income - This is the total income generated by all the resources for this event.

Cost - This is the total cost of all the resources used for this event.    The cost for each resource is 
determined by multiplying the allocated time by the resource cost as defined in the resource 
definition.

Calculate based on - The information in this box determines what method of calculation will be used with
this event.    One of the following methods may be used:

Duration - Interpret the entered quantities as elapsed time and calculate the "Total Time" used by all 
resources.

Time for All Resources - Interpret the entered quantities as "Total Time" used by all resources and 
calculate the duration (elapsed time).

Time per Resource - Interpret the entered quantity as the time used by the first resource in the 
resource list and calculate an elapsed time for the event.    Then use the elapsed time to calculate the 
total time used by all resources.



Days (Calculate based on) - Number of days.

Hrs (Calculate based on) - Number of hours.

Min (Calculate based on) - Number of minutes.

Show Days (Calculate based on) - To display the number of days for a defined quantity click on this 
control to place an X in it.

1 Day = 8 Hours (Calculate based on) - This is used for the condition when a typical work day is 8 hours
long.    To see the quantity displayed in number of working days, enable this option by clicking on this 
control to place an X in it. 

Class - This is used as additional information to identify similar types of events.

Line - The line number on the planning grid that the event will be displayed on.    You can change this to 
move an event vertically.

Fixed Income - A fixed income in dollars that is associated with this event.    A decimal point may be used 
for fractions of dollar.

Fixed Cost - A fixed cost in dollars that is associated with this event.    A decimal point may be used for 
fractions of dollar.

Predecessors - List of defined predecessor events for this event.    The event cannot start until all the 
predecessor events have been completed.

Resources - List of resources used for this event.

Notes - Additional notes about this event.

Predecessors (Button) - This button invokes a dialog box to define the predecessor events.    To place 
an event into the "Selected Predecessors" list, click on the event name in the "Existing Events" list then 
click on the "Insert" button.

Once an event has been placed on the "Selected Predecessors" list it may be deleted or moved.    To 
delete the event from this list, click on the event name then click on the "Delete" button.    To move the 
event, click on the event name then click on the "Move Up" or "Move Down" button.

Resources (Button) - This button invokes a dialog box to define the resources for the event.    To select a
resource, click on the resource name in the "Resources" list.    A default "Usage %" and calendar 
assignment will be made.    The "Usage %" can be changed by entering a new percentage and the 
assigned calendar can be changed by clicking on a different calendar name in the "Calendar" list.

Use the "Replace", "Insert" (insert before), or "Add" (add to end of selected list) buttons to place the 
resource into the "Selected Resources" list.

Once a resource has been placed into the selected list, it may be deleted with the "Delete" button or 
moved with the "Move Up" or "Move Down" buttons.

Calculate (Button) - After an input quantity has changed, this can be used to force a re-calculation and to
display the results in the dialog box.

Print (Button) - Use this to print the current dialog box contents.



How to Select Multiple Events

The Edit menu Duplicate, Delete, and Move options let you select a group of events using a dialog box.    
You can also select a group of events using the mouse.

To select all the events in a line, click on the line number.

To create a group of selected events, click on the first one you want to include in the group.    To add 
another event to the group of selected events, hold the CTRL key down and click on another event.    
Continue the CTRL/click process until you have selected all the events to include in the group.

To move a group of selected events, position the mouse cursor over any event that is in the group.    
Press the mouse button, drag the event to the new position, and release the mouse button.    All events in 
the group will also be moved to new positions relative to how you moved the event you dragged.

To duplicate a group of selected events, position the mouse cursor over any event that is in the group.  
Hold the CTRL key down and press the mouse button and drag the event to the new position.    With the 
CTRL key still down, release the mouse button and the events will be copied. Now release the CTRL key. 
Copies of all events in the group will be created at new positions relative to how you moved the event you
dragged.

To de-select a group of selected events, click anywhere (except over a currently selected event) in the 
planning grid.



How to Work with Calendar Schedules

A calendar contains calendar schedules which define available time.    A resource will have available time 
as specified by the calendar assigned to it.

Multiple Schedules
It is possible to have more than one schedule assigned to a given date.    However, only one schedule is 
applied at any given time.    When determining what schedule to apply to a date, the following type order 
is used:

1. "Do Not Repeat"
2. "Every Year"
3. "Every Month"
4. "Pattern"
5. "Default"

When more than one schedule of a type is defined, the one defined last is applied first.

The "Assigned Schedules" list box lists the schedules assigned to the currently selected date.    To view 
the time schedule, select the schedule name from the list box.

Changing Time
The schedule is determined by the state of the information shown in the vertical box labeled as "Time".    
This time schedule applies to the item that currently appears in the "Assigned Schedules" box.

To change the time schedule for the current item, click on the time bars to turn the state of the time 
periods from available (green) to not-available (red).    The changes are immediately accepted with no 
confirmation dialog box.    However, to revert back to the original time schedule click on the "Revert" 
button.

Buttons
New - Immediately after selecting a date, click on this button to create a new schedule.

Delete - Use this to delete the currently displayed schedule.

Rename - Use this to rename the currently displayed schedule.

Revert - This button is enabled whenever it is possible to revert back to an original time schedule and 
discard any changes.



File Menu

This menu does not deal with files in the traditional sense, but operates on the plan, resource, or calendar
document window (see Multiple Document Interface) which is currently active.    You assign names to 
the plans, resources, and calendars, but the actual file names for the data are automatically managed by 
the program.

The options available in this menu will vary depending on the type of document window that is currently 
active.



File - New

Use this option to create a new plan, calendar, or resource.

When the dialog box appears, click on the type of item (represented by radio buttons) you want to create 
and click on "OK".    A corresponding document window representing the new item to create will then 
appear.

Refer to the "How To" topics Create a Calendar, Create a Plan or Create a Resource for more detailed 
information.



File - Open

Use this option to open an existing plan, calendar, or resource.

When the dialog box appears, click on the type of item (represented by radio buttons) you want to open 
and the list on the left side will be loaded with all the names of the selected type.    Click on the desired 
item and click on "OK" to open it.

You may also double-click on an item name to open it.

Options - This button can be used to automatically open a plan on startup.

When you click on the Options button a dialog box appears.    To enable the auto-open option, click on
the "On startup, automatically..." check box so that an X appears in it.    The program can either 
automatically open the last plan you closed or it can automatically open a specific plan on startup.    
To specify your choice, click on the appropriate radio button.

If you want to change the name of the "Current default choice", click on the "Choose a new default" 
radio button and select a different name from the list box.



File - Close

Use this option to close the active plan, calendar, or resource document window.    If any changes were 
made, you will be prompted to save or ignore the changes.    If you are closing a new item, you be 
prompted to enter a name for the item.



File - Save

Use this option to save the data in the active plan, calendar, or resource document window.



File - Save As

Use this option to save the plan, calendar, or resource in the active document window with a new name 
and use the original document as the basis for a new one.    When the dialog box appears, just enter the 
new name in the "Name:" field.    This is equivalent to copying a document.



File - Delete

Use this option to delete a plan, calendar, or resource.

When the dialog box appears, click on the type of item (represented by radio buttons) you want to delete 
and the list on the left side will be loaded with all the names of the selected type.    Click on the desired 
item to delete and click on "OK" to delete it.    A confirmation dialog box will then appear to confirm your 
intent to delete the item.

You may also double-click on an item name to select it for deletion.

After you have deleted all the items that you want deleted, click on "Cancel" to close the delete dialog 
box.



File - Print

Use this option to print the reports for the plan, calendar, or resource in the active document window.

Before any printing is started, a common print dialog box appears to let you change the margins, number 
of copies, and select a page range to print.    In this dialog box, two additional buttons are also available:

Font - This lets you select the font for the report.    This setting will remain in effect until the program 
exits.    You also have the option to save the font setting so it becomes the default font the next time 
the program runs.    (Note: This font selection does not affect the plan layout report which uses the 
current plan font as it appears on the screen.)

Setup - This invokes the standard printer setup dialog box which includes options to change the 
paper orientation and size.

If a resource is the active document window, all the information for the resource is printed.

If a calendar is the active document window, all the information for the calendar is printed.

If a plan is the active document window, a sub-menu of plan reports appears.    See the following topics 
which describe these reports:

File - Print Plan Layout
File - Print Plan Summary
File - Print Events
File - Print Resource Assignments
File - Print Resource Work Load



File - Print Plan Layout

Use this option to print a plan layout as it appears on the screen.    A dialog box appears with the following
options:

Line Selection - Click on the "All in plan" radio button to print all the plan lines (this is the default setting). 
To specify a range, click on the "From" radio button.    You can then enter the desired range of lines to 
print.

Time Selection - Click on the "All in plan" radio button to select a time to include all the events in the plan
(this is the default setting).    To specify a range, click on the "From" radio button.    You can then enter a 
desired time range.    Enter time in the "MM/DD/YY HH:MM" format.

Grid Background Color - By default the "Remove Grid Background Color" check box contains an X.    If 
you want the background color to be printed, click on the check box to remove the X

Event Background Color - By default, the event background colors will be printed.    If you want to force 
a white background, click on the "Use White for Event Backgrounds" check box to place an X in it.

NOTE: If you do not have a color printer, Windows will print colors in various shades of gray but they may 
not be easy to distinguish.

After the layout options have been selected, the common print dialog box will appear.



File - Print Plan Summary

Use this option to print summary information about the active plan.    Information such as the plan start 
time, plan end time, plan duration, total income, total cost, number of events, and number of resources 
are included in the report.

There are no special options for this report so only the common print dialog box will appear.



File - Print Events

Use this option to print a list of events from the active plan.    For each event, the line number, event 
name, start time and end time are included in the report.      A dialog box appears with the following 
options.

Sort Order - This drop-down list box lets you a choose a sort order based on event start time, event end 
time, event name, or line number and event start time (this last sort order will display the events in the 
order they appear on the screen in a left to right and top to bottom order).

Item for Last Report Column - You may include one additional column of information in this report by 
choosing one item in this drop-down list box.    Choices include event class, event description, event 
duration, net income, predecessors, assigned resources, time allocation, total cost, and total income.

Filter Option: Time - Use this filter option when you want to include events in a certain time period.    To 
enter a time range, click on the "From:" radio button.    This will then enable the from/to time range fields.   
Enter the time in "MM/DD/YY HH:MM" format.

Filter Option: Lines - Use this filter option when you want to include events that are displayed on a 
contiguous group of lines.    To enter a line range, click on the "From:" radio button.    This will then enable 
the from/to fields where you can enter the line number range.

Filter Option: Resource - This drop-down list box contains all the resources in the current plan.    Use 
this option to include events assigned to a specific resource.    If you want to include all events without 
regard to resource usage, select the "<All>" entry in the drop-down list box.

Filter Option: Class - Use this filter option to include only events that match the class that you specify.

NOTE: The class you enter must exactly match the event class in 
order for this filter test to pass.

NOTE: All filter options must pass in order for the event to be 
included in the report.

After the report options have been selected, the common print dialog box will appear.



File - Print Resource Assignments

Use this option to print a list of events assigned to each resource (from the active plan).    For each event, 
the resource name, event name, start time and end time are included in the report.      A dialog box 
appears with the following options.

Sort Order - This drop-down list box lets you a choose a sort order based on resource name and event 
start time, resource name and event end time, or resource name and event name.

Item for Last Report Column - You may include one additional column of information in this report by 
choosing one item in this drop-down list box.    Choices include event class, event description, event 
duration, predecessors, resource class, resources, resource allocation, resource cost, resource income, 
and resource net income.

Filter Option: Time - Use this filter option when you want to include events in a certain time period.    To 
enter a time range, click on the "From:" radio button.    This will then enable the from/to time range fields.   
Enter the time in "MM/DD/YY HH:MM" format.

Filter Option: Resource - This drop-down list box contains all the resources in the current plan.    Use 
this option to include events assigned to a specific resource.    If you want to include all events without 
regard to resource usage, select the "<All>" entry in the drop-down list box.

Filter Option: Resource Class - Use this filter option to include only events that match the resource 
class that you specify.

Filter Option: Event Class - Use this filter option to include only events that match the event class that 
you specify.

NOTE: The class you enter must exactly match the resource or 
event class in order for this filter test to pass.

NOTE: All filter options must pass in order for the event to be 
included in the report.

Start New Page for Each Resource - When an X is placed in this check box, a new page will be started 
for each resource.    This is useful when you distribute printed copies of the report to individuals so that 
only their assignments will be on the report they receive.

After the report options have been selected, the common print dialog box will appear.



File - Print Resource Work Load

Use this option to print a the work load table for each resource from the active plan.    For each resource, 
the date, event name, and allocated time is included in the report.      A dialog box appears with the 
following options.

Filter Option: Time - Use this filter option when you want to include events in a certain time period.    To 
enter a time range, click on the "From:" radio button.    This will then enable the from/to time range fields.   
Enter the time in "MM/DD/YY HH:MM" format.    Since the work load is shown on a daily basis, you may 
want to specify a time range filter when working with long plans.

Filter Option: Resource - This drop-down list box contains all the resources in the current plan.    Use 
this option to include the work load for a specific resource.    If you want to include all resources, select the
"<All>" entry in the drop-down list box.

Filter Option: Resource Class - Use this filter option to include only resources that match the resource 
class that you specify.    Note that the class you enter must exactly match the class in order for this filter 
test to pass.

NOTE: All filter options must pass in order for the event to be included in 
the report.

Start New Page for Each Resource - When an X is placed in this check box, a new page will be started 
for each resource.    This is useful when you distribute printed copies of resource assignments to 
individuals so that only their assignments will be on the report they receive.

Load Threshold - When an X is placed in the "Mark days which exceed a load threshold of" check box, 
you can enter a threshold value.    In the report, any day that has more time allocated than this threshold 
amount will be marked with "**" on the report.

After the report options have been selected, the common print dialog box will appear.



File - Print Setup

Use this to display the standard printer setup dialog box which allows the printer to be changed and also 
allows changes to options such as the paper orientation and size.



File - Exit

Use this to exit the application.



Edit Menu

This menu is used to edit a plan document so the options are enabled only when a plan document 
window is active.    The Cut, Copy, and Paste options are also available when editing text in a resource 
document window.



Edit - Cut

This option is enabled when one or more events in a plan have been selected.    Choosing this option will 
cause the selected events to be stored in the paste buffer and deleted from the current plan.

The data stored in the paste buffer is in a special format that only this program can understand so you will
not be able to paste the selected events into another application.



Edit - Copy

This option is enabled when one or more events in a plan have been selected.    Choosing this option will 
cause the selected events to be copied to the paste buffer.

The data stored in the paste buffer is in a special format that only this program can understand so you will
not be able to paste the selected events into another application.



Edit - Paste

This option is enabled when events have previously been cut or copied to the paste buffer.    Choosing 
this option will cause the events stored in the paste buffer to be added to the current plan.

Paste will use all the original event information such as the line number, start time, etc. and try to place 
the event in the same location it was when it was cut or copied.    If an event with the same name already 
exists, paste will assign a new name to the event to be pasted.    The new name will have a "_N" 
appended to it where "N" is a number that will make the event name unique.



Edit - New

Use this option as an alternative to using the mouse to create a new event.    The event dialog box will 
appear to let you enter the information for the new event.    This is the same dialog box that appears when
you modify an event.    See the Modify an Event topic for more detailed information.



Edit - Duplicate

Use this option as an alternative to using the mouse to duplicate events.    If a group of two or more 
events are currently selected, a dialog box will appear to let you change the list of events to duplicate.    
This dialog box will allow you to duplicate multiple events and has the following options:

Event Names - This provides a list of events that you can choose from to place into the list of selected 
events.

Selected Events - This is the group of events that will be duplicated.    It is initially loaded with the current 
set of selected events.    When you click on "OK" all of these events will be duplicated.

Add button - The event selected from the Event Names list will be added to the Selected Events list.

Remove button - The event high-lighted in the Selected Events list will be removed from the Selected 
Events list.

Options to Shift Events: Line - Enter a positive or negative number to shift the duplicated events.    This 
number is added to the line number of the original event so you may shift an event down with a positive 
number or up with a negative number.

Options to Shift Events: Days, Hours, Minutes - Enter a positive or negative value to shift the 
duplicated events.    The time is added to the start time of the original event, so you may shift an event to 
a later time with a positive number or to an earlier time with a negative number.

NOTE:    The shift values are applied to all the selected events.

If no events have been selected or only one event has been selected an intermediate dialog box will 
appear with the following options:

Name - The currently selected event, if one is selected, will appear here as the default.    You may select 
any event that appears in the list box below.    If you click on "OK", the event's detailed dialog box will 
appear so you can make any other modifications for the duplicated event.

More than one... button - If you click on this button, the dialog box to allow duplication of multiple events 
(as described above) will appear.

In summary, duplicate will allow you to change event details if you duplicate one event at a time, but if you
duplicate multiple events, you can only shift the line number and start time of each event.



Edit - Delete

Use this option to delete one or more events.    A dialog box will appear to let you create the list of events 
to delete.    This dialog box has the following options:

Event Names - This provides a list of events that you can choose from to place into the list of selected 
events.

Selected Events - This is the group of events that will be deleted.    It is initially loaded with the current 
set of selected events.    When you click on "OK" all of these events will be duplicated.

Add button - The event selected from the Event Names list will be added to the Selected Events list.

Remove button - The event high-lighted in the Selected Events list will be removed from the Selected 
Events list.

Move Up button - The events will be deleted in the order shown on the list.    Use this button to move the 
highlighted name in the Selected Events list up by one position.

Move Down button - Use this button to move the highlighted name in the Selected Events list down by 
one position.

NOTE:    Each event can only have a limited number of 
predecessors.    If you delete an event, the program will try to re-link 
the events.    For example if event A is a predecessor to event B 
which is in turn a predecessor to event C, when you delete event B, 
event A will become an immediate predecessor to event C.    
However, if event B has 8 predecessors and event C has 8 
predecessors (including event B), when you try to delete B, C may 
need to have 15 predecessors defined.    This will exceed the limit 
allowed by the program.    In this example, if you are trying to delete 
both events B and C, delete event C first and then delete event B.



Edit - Modify

Use this option to modify the information for any event.    A dialog box will appear with the following 
options:

Name - The currently selected event, if one is selected, will appear here as the default.    You may select 
any event that appears in the list box below.    If you click on "OK", the event's detailed dialog box will 
appear so you can make any other modifications to the selected event.

See the Modify an Event topic for more detailed information.



Edit - Move

Use this option as an alternative to using the mouse to move events.    A dialog box will appear to let you 
define the list of events to move.    This dialog box has the following options:

Event Names - This provides a list of events that you can choose from to place into the list of selected 
events.

Selected Events - This is the group of events that will be moved.    It is initially loaded with the current set
of selected events.    When you click on "OK" all of these events will be moved.

Add button - The event selected from the Event Names list will be added to the Selected Events list.

Remove button - The event high-lighted in the Selected Events list will be removed from the Selected 
Events list.

Options to Shift Events: Line - Enter a positive or negative number to shift the events.    This number is 
added to the line number of the original event so you may shift an event down with a positive number or 
up with a negative number.

Options to Shift Events: Days, Hours, Minutes - Enter a positive or negative value to shift the events.    
The time is added to the start time of the original event, so you may shift an event to a later time with a 
positive number or to an earlier time with a negative number.

NOTE:    The shift values are applied to all the selected events.



Edit - Insert Line

Use this option to insert one or more lines in a plan.    This has the effect of shifting all events down by the
number of lines inserted.    A dialog box will appear with the following options:

Insert before line - Enter the line number to identify the starting point at which lines will be inserted.

Number of lines - Enter the number of lines to be inserted.



Edit - Clear Line

Use this option to clear one or more lines in a plan.    This has the effect of deleting all events on the 
selected lines.    A dialog box will appear with the following options:

From Line - Enter the line number to identify the starting point at which lines will be cleared.

To Line - Enter the line number to identify the ending point at which lines will be cleared.



Edit - Delete Line

Use this option to delete one or more lines in a plan.    This has the effect of deleting all events on the 
selected lines and shifting up all events by the number of lines deleted.    A dialog box will appear with the 
following options:

From Line - Enter the line number to identify the starting point at which lines will be deleted.

To Line - Enter the line number to identify the ending point at which lines will be deleted.



Info Menu

This menu provides options to view and modify general information about the currently active calendar or 
plan.



Info - Calendar

Use this option to display a dialog box which shows the number of schedules defined for the currently 
active calendar and allows changes to the following optional information:

Description - A description of the calendar to supplement the name.

Class - You may define a classification for the calendar.



Info - Plan

Use this option to display a dialog box which shows overall plan information.    The dialog box also allows 
changes to the following information:

Description - A single line description to supplement the name.

Default Resource - Select any resource included in the drop-down list box as the default resource.    
When a new event is created, this resource is assigned as the default resource.

Default Calendar - Select any calendar included in the drop-down list box as the default calendar.    
When a new event is created, this calendar is assigned to the default resource.

Usage % - When a new event is created, this default utilization percent is assigned to the default 
resource and calendar.    Enter a number within the range from 1 to 100.

Notes - Provides space for more detailed notes about the plan.

Additional information displayed include:
Start Time: (plan start time)
End Time: (plan end time
Duration: (plan duration)

Total Income: (total plan income)
Total Cost: (total plan cost)

Resources Used: (list of resources used)
Resources: (number of resources used)
Total Time: (total resource time allocated)

Events: (number of events)



Reports Menu

This menu provides options to print reports that apply to all resources, calendars, or plans.    You do not 
have to have a resource, calendar, or plan document window active, as required for the File Menu Print 
options.

For information on the various reports in the menu, see the following topics:
Reports - Resource List
Reports - Calendar List
Reports - Plan List
Reports - Assignments for One Resource
Reports - Work Load for One Resource
Reports - Hours Summary for All Plans
Reports - Income Summary for All Plans



Reports - Resource List

Use this option to view a simple list of resources.    The list is ordered by resource name and includes the 
resource description and default calendar.    If you want to print the list, click on the "Print" button.

Note:    The printed list will not include the default calendar name.



Reports - Calendar List

Use this option to view a simple list of calendars.    The list is ordered by calendar name and includes the 
calendar description and the number of schedules defined for the calendar.    If you want to print the list, 
click on the "Print" button.

Note:    The printed list will not include the number of schedules.



Reports - Plan List

Use this option to view a simple list of plans.    The list is ordered by plan name and includes the plan 
description and the number of events defined for the plan.    If you want to print the list, click on the "Print" 
button.

Note:    The printed list will not include the number of events.



Reports - Assignments for One Resource

Use this option to print a list of events from all plans for one resource.    For each event, the plan name, 
event name, start time and end time are included in the report.      A dialog box appears with the following 
options.

Sort Order - This drop-down list box lets you a choose a sort order based on event start time, event end 
time, event name and plan name, or plan name and event name.

Item for Last Report Column - You may include one additional column of information in this report by 
choosing one item in this drop-down list box.    Choices include event class, event description, event 
duration, predecessors, resource class, resources, resource allocation, resource cost, resource income, 
resource net income.

Filter Option: Time - Use this filter option when you want to include events in a certain time period.    To 
enter a time range, click on the "From:" radio button.    This will then enable the from/to time range fields.   
Enter the time in "MM/DD/YY HH:MM" format.

Filter Option: Resource - This drop-down list box contains all resources.    You must select one resource 
for this report.

Filter Option: Event Class - Use this filter option to include only events that match the class that you 
specify.

NOTE: The class you enter must exactly match the event class in 
order for this filter test to pass.

NOTE: All filter options must pass in order for the event to be 
included in the report.

After the report options have been selected, the common print dialog box will appear.



Reports - Work Load for One Resource

Use this option to print a the work load table for one resource in all plans.    For each day, the plan name, 
event name, and allocated time is included in the report.      A dialog box appears with the following 
options.

Filter Option: Time - Use this filter option when you want to include events in a certain time period.    To 
enter a time range, click on the "From:" radio button.    This will then enable the from/to time range fields.   
Enter the time in "MM/DD/YY HH:MM" format.    Since the work load is shown on a daily basis, you may 
want to specify a time range filter when working with long plans.

Filter Option: Resource - This drop-down list box contains all resources.    You must select one resource 
for this report.

NOTE: All filter options must pass in order for the event to be included in 
the report.

Load Threshold - When an X is placed in the "Mark days which exceed a load threshold of" check box, 
you can enter a threshold value.    In the report, any day that has more time allocated than this threshold 
amount will be marked with "**" on the report.

After the report options have been selected, the common print dialog box will appear.



Reports - Hours Summary for All Plans

Use this option to get a summary report for all plans.    The information for each plan includes the plan 
name, plan start date, plan end date, duration in days, number of events, and total resource allocation in 
hours.    A dialog box appears with the following options:

Sort Order - This drop-down list contains the different sort orders available.    These include sorting by 
allocation, duration, end date, number of events, plan name, and start date.

After the report options have been selected, the common print dialog box will appear.



Reports - Income Summary for All Plans

Use this option to get an income summary report for all plans.    The information for each plan includes the
plan name, plan start date, plan end date, income, and cost.    A dialog box appears with the following 
options:

Sort Order - This drop-down list contains the different sort orders available.    These include sorting by 
cost, end date, income, plan name, and start date.

After the report options have been selected, the common print dialog box will appear.



Options Menu

This menu provides various functions that are applicable on a program wide basis, or in some cases are 
specific to the currently active calendar, resource, plan.



Options - Directories

This option is only enabled when there are no opened plan, calendar, or resource document windows.    
Use this to specify the location of the data files (collectively referred to as the database) and the location 
of the help file.    A dialog box appears with the following options:

Data Directory Path - Enter the full directory path (including drive name) for the database here.    The 
default value is the default directory when the program is executed.    An example path is show below:

c:\aplanr\myplans

If the directory you choose does not have any existing data, a blank set of files will be automatically 
created.

Save as default data directory - If you place an X in this check box, the data directory path specified 
above will be used as the data directory and not the default directory when the program is executed.    By 
using this option, you can force the program to always use a specific database on startup.

Help Directory Path - Enter the full directory path (including drive name) for the help file.    The default 
value is the directory where the program is executed from.

Save as default help directory - If you place an X in this check box, the help directory path specified 
above will be used as the default help directory and not the directory where the program is executed from.

NOTE: You may have different sets of plans in different directories, 
however be aware that a plan can only use the resources and 
calendars that are in the same directory (i.e. in the same database) 
as the plan.    To maintain the integrity of the database, all of the 
files within the directory should be saved or restored completely as 
a group.



Options - Export

Use this option to export data into a text file.    Each line in the file represents one record of information.    
Within each line, each field of information is separated by a user specified delimiter character.    Also each 
text field may be surrounded by a user specified character.    An example of an exported file is shown 
below:

"PlanName","EventName","Line","StartTime"
"Sample Project","Code Part A",3,11/29/1993 17:00
"Sample Project","Code Part B",4,11/24/1993 17:00
"Sample Project","Design Part A",3,11/17/1993 17:00
"Sample Project","Design Part B",4,11/17/1993 17:00
"Sample Project","Final Testing",5,12/14/1993 17:00

The first line, which is optional, contains a list of field names.    This will tell you the order in which the data
appears in the lines that follow.    All the lines after the first represent the data.    In this example the field 
delimiter is a comma and text fields are delimited by quotes.    Note also that time fields are displayed in 
"MM/DD/YYYY HH:MM" format.

All of the export options use very similar dialog boxes, so they will be described here.    For the data 
content of the export files, refer to the respective topics:

Options - Export Resource List
Options - Export Plan List
Options - Export Events by Resources
Options - Export Events by Plans

The initial dialog box that appears contains the following options:

Output Options: Filename - Enter a path and filename to over-ride any existing default name.    The 
usual default filename is export.dat.

Output Options: Delimiter (Field) - Enter a single character to use to separate fields.    This character 
must not be contained within any of the data fields.    The default delimiter is comma.    A field delimiter 
must be specified.

Output Options: Delimiter (Text) - Enter a single character to use to surround text fields.    This 
character must not be contained within any of the text fields and it cannot be the same as the field 
delimiter.    The text delimiter is optional.

Output Options: Append data to file. - Place an X in this check box if you want the exported data to be 
appended to an existing file.    Otherwise, data in an existing export file will be over-written.

Output Options: Insert field names at beginning - Place an X in this check box if you want the first line 
of the file to contain the data field names.

Filter Options: Select Resources button - If applicable to the selected export function, this button will 
be enabled.    Above this button will be the list of resources that will be included in the data.    If you want 
to the change the list of resources, click on the "Select Resources" button and another dialog box will 
appear with the following options:

Resources Available - This list box will contain a list of all resources that match the specified Class 
filter which appears below the list box.

Selected Resources - Use the add, add all, remove, remove all buttons to build the items in this list 
box.    The resources that appear in this list will be included in the exported data.



Class Filter - If you want to limit the list shown in the "Resources Available" list box, enter a resource 
class here and press the <tab> key.    As soon as the <tab> key is pressed, the "Resources Available" 
list box will be updated with all of the resources that match the class filter.    Leave this class filter 
blank if you want all resources shown in the "Resources Available" list box.

Add button - To add a resource to the "Selected Resources" list, select one from the "Resources 
Available" list and click the "Add" button.

Add All button - To add all resources from the "Resources Available" list to the "Selected Resources"
list, click the "Add All" button.

Remove button - To remove a resource from the "Selected Resources" list, highlight the item in the 
"Selected Resources" list with a mouse click then click on the "Remove" button.

Remove All button - To remove all resources from the "Selected Resources" list, click on the 
"Remove All" button.

Filter Options: Select Plans button - If applicable to the selected export function, this button will be 
enabled.    Above this button will be the list of plans that will be included in the data.    If you want to the 
change the list of plans, click on the "Select Plans" button and another dialog box will appear with the 
following options:

Plans Available - This list box will contain a list of all plans.

Selected Plans - Use the add, add all, remove, remove all buttons to build the items in this list box.    
The plans that appear in this list will be included in the exported data.

Add button - To add a plan to the "Selected Plans" list, select one from the "Plans Available" list and 
click the "Add" button.

Add All button - To add all plans from the "Plans Available" list to the "Selected Plans" list, click the 
"Add All" button.

Remove button - To remove a plan from the "Selected Plans" list, highlight the item in the "Selected 
Plans" list with a mouse click then click on the "Remove" button.

Remove All button - To remove all plans from the "Selected Plans" list, click on the "Remove All" 
button.

Filter Options: Event Class - If applicable to the selected export function, this field will be enabled and 
you can enter a class value to limit the exported data to only the events which match the specified class. 



Options - Export Resource List

Refer to the Options - Export topic for information on how to interact with the dialog boxes.

All resource information will be exported with data fields the following order:

1. "ResourceName"
2. "FullName"
3. "Description"
4. "Calendar"
5. "Class"
6. "DefaultUsage"
7. "Cost"
8. "CostTime"
9. "Income"
10. "IncomeTime"



Options - Export Plan List

Refer to the Options - Export topic for information on how to interact with the dialog boxes.

Plan summary information will be exported with data fields in the following order:

1. "PlanName"
2. "Title"
3. "DefaultRsc"
4. "DefaultCal"
5. "DefaultUsage"
6. "StartTime"
7. "EndTime"
8. "Duration"
9. "TotalIncome"
10. "TotalCost"
11. "NumResrc"
12. "NumEvents"
13. "ResrcTime"
14. "Resources"

The last data field will contain the names of all the resources for the plan.    The number of values in this 
field is specified by the "NumResrc" field.



Options - Export Events by Resources

Refer to the Options - Export topic for information on how to interact with the dialog boxes.

Event information will be exported with data fields in the following order:

1. "ResrcName"
2. "PlanName"
3. "EventName"
4. "Description"
5. "Class"
6. "Line"
7. "StartTime"
8. "EndTime"
9. "Duration"
10. "VarIncome"
11. "FixIncome"
12. "TotalIncome"
13. "VarCost"
14. "FixCost"
15. "TotalCost"
16. "Predecessors"
17. "P2"
18. "P3"
19. "P4"
20. "P5"
21. "P6"
22. "P7"
23. "P8"
24. "Resources"
25. "R2"
26. "R3"
27. "R4"
28. "R5"
29. "R6"
30. "R7"
31. "R8"
32. "Calendars"
33. "C2"
34. "C3"
35. "C4"
36. "C5"
37. "C6"
38. "C7"
39. "C8"

P2-P8 refer to predecessors 2 to 8, R2-R8 refer to resources 2 to 8, and C2-C8 refer to calendars 2 to 8.



Options - Export Events by Plans

Refer to the Options - Export topic for information on how to interact with the dialog boxes.

Event information will be exported with data fields in the following order:

1. "PlanName"
2. "ResrcName"
3. "EventName"
4. "Description"
5. "Class"
6. "Line"
7. "StartTime"
8. "EndTime"
9. "Duration"
10. "VarIncome"
11. "FixIncome"
12. "TotalIncome"
13. "VarCost"
14. "FixCost"
15. "TotalCost"
16. "Predecessors"
17. "P2"
18. "P3"
19. "P4"
20. "P5"
21. "P6"
22. "P7"
23. "P8"
24. "Resources"
25. "R2"
26. "R3"
27. "R4"
28. "R5"
29. "R6"
30. "R7"
31. "R8"
32. "Calendars"
33. "C2"
34. "C3"
35. "C4"
36. "C5"
37. "C6"
38. "C7"
39. "C8"

P2-P8 refer to predecessors 2 to 8, R2-R8 refer to resources 2 to 8, and C2-C8 refer to calendars 2 to 8.



Options - Report Font

Use this option to change the font for reports (other than the plan layout report).    A dialog box will appear 
which will show the current font selection and the following options:

Fonts button - Use this button to select a new font.    A standard Windows dialog box will appear to let 
you select a new font.

Save as new default (in initialization file) - Place an X in this check box if you want this font to become 
the new default font the next time you run this program.    Otherwise the font you select will only be used 
during the current execution of this program.



Options - Scale

This option is only enabled when a plan or a calendar is the active document.    With a plan document, this
option specifies the time resolution of each column in the planning grid.    With a calendar document, this 
option specifies the resolution of the available time display.

For a plan document, a dialog box appears with the following fields:

Column Time Scale - Each column may represent an hour (with hours labeled from 0 to 23 or with 
hours labeled 1 to 12 am/pm), day, week, month, or year.

Mouse Cursor Resolution Units - The mouse position will be rounded to the specified units of days, 
hours, or minutes.

Event Duration Resolution - When the event is created with the mouse, the duration will be rounded
to some multiple of the amount specified here.    For example if the value in this field is one and the 
"Mouse Cursor Resolution Units" is "days", then the event duration will be rounded to the nearest day.

Column Width - The width of each displayed column in logical inches.

Line Height - The height of each displayed line in logical inches.

For a calendar document, a dialog box appears with the following fields:

Time Resolution of Day's Schedule - This specifies the number of minutes for each time segment in
the time display.

Default Start Time - This specifies the start time that appears at the top of the time display.



Options - Shift Events

This option is only enabled when a plan is the active document.    Use this to shift all the events in the 
current plan by a specified amount.    A dialog box will appear with the following fields:

Time Shift Quantity - Enter the amount to shift the start time of each event.    Enter a positive value to 
move events to a later time.    Enter a negative value to move events to an earlier time.

Units - Select the quantity units from this drop-down list box.    The units may be specified in minutes, 
hours, or days.



Options - Colors and Fonts

This option is only enabled when a plan is the active document.    It provides the capability to select colors
and fonts to customize the appearance of a plan.    The sections of the dialog box which appears are 
described below.

Sample - The sample area located on the left side of the dialog box displays the currently selected colors 
and fonts.    As different fonts and colors are selected, the sample area is automatically updated so you 
can decide if you really want the font and color combinations.    Use the "OK" button to save the color 
scheme or the "Cancel" button to ignore it.

Grid Font - Use this button to change the font for the planning grid time labels at the top of a plan and the
row numbers that appear on the left side of a plan.

Event Font - Use this button to change the font displayed within each event.

Planning Grid Colors - Use this section to change the colors in the planning grid.

Select "Use standard program colors" from the list box to use the standard color scheme as specified 
in the .INI file (see Windows Initialization File).

Select "Use user-defined colors" to specify a color scheme that is specific to this plan only.    In this 
case use the    "Background", "Labels", and "Lines" buttons to choose colors independently.    

Select "Use Windows desktop colors" to use the same color scheme as specified by the Windows 
Control Panel.

Event Colors - Use this section to change the colors for the currently selected event.    If no event is 
selected, this section lets you specify what default colors to use when creating new events.

Select "Use standard program colors" from the list box to use the standard color scheme as specified 
in the .INI file (see Windows Initialization File).

Select "Use event-specific colors" to specify a color scheme for the currently selected event only.    In 
this case use the "Background", event name "Text", and event "Border" buttons to choose the colors 
independently.

Select "Use current plan default" to specify a color scheme default and apply it to the currently 
selected event.    All events which use the default as a color selection will automatically change to the 
new default colors.

If the "Apply to all existing events in plan" checkbox is checked, the currently specified colors will be 
applied to all events.    This option is useful when you want to change all the colors back to a uniform 
color scheme.



Window Menu

Tile - Follows the multiple document window interface for tiling the windows.

Cascade - Follows the multiple document window interface for cascading the windows.

Arrange Icons - Follows the multiple document window interface standards for arranging the icons for the
open documents.

Close All - Close all the opened plans, resources, and calendars.



Help Menu

Help - Provides help on this application.

About - Provide version information about this application.

Registration - Provides information on how to register this program and a way to print the registration 
form.    See the Shareware Registration topic.




